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1 About PSTWay 

PSTWay allows users of Microsoft Outlook Web Access (OWA) to access Outlook personal folders stored in 
PST files on the corporate network. Users are granted access to their PST files by the FileWay Administrator. 
Users may add and remove emails from their PST files. Refer to section 11 to see PSTWay in action. 

PSTWay integrates with FileWay. Specifically, PSTWay and FileWay have 2 components in common: FileWay 
BackEnd and FileWay Manager. If you already have FileWay installed in your organization, you do not need to 
reinstall it; however, you must upgrade to version 3.4. The PSTWay Installer includes FileWay Version 3.4. 

If you  have not installed FileWay, note that FileWay BackEnd and FileWay Manager are included with 
PSTWay.  

PSTWay comprises the following: 

·  PSTWay Components for OWA Servers 

·  PSTWay Service for Outlook Server 

·  FileWay BackEnd which includes FileWay Manager 

PSTWay Components for OWA Servers integrates with MS Exchange 2007 OWA to provide the functionality that 
allows users to access their PST files stored on the corporate network. PSTWay Service For Outlook Server 
resides on a separate server and helps link .pst files with the Components for OWA Servers.  FileWay BackEnd 
provides the user access controls to resources on the network.  FileWay Manager is a Windows application that 
Administrators use to specify users’ access rights for corporate drives and shared folders. 

PSTWay Service for Outlook Server must be installed on a separate server but all the other  components can 
be installed together on the same server or separately depending on the configuration you choose.  From a 
performance point of view, there is no difference whether you install on one or multiple servers.  However, if you 
have multiple servers hosting OWA, then PSTWay Component for OWA Server must be installed on each 
server. 

Note that if FileWay Version 3.4 components are already installed in your organization, you do not need to install 
them again. If want to share your existing FileWay components with PSTWay, you must upgrade to FileWay 3.4 
components. 
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2 Requirements 

This chapter describes the minimum system requirements for installing PSTWay. 

2.1 PSTWay Software Requirements 

2.1.1 Exchange 2007 Outlook Web Access (OWA) Server (s)  

·  Microsoft WindowsTM 2008 Standard or Enterprise Edition 

·  Microsoft WindowsTM 2003 Server Standard or Enterprise Edition  

·  Microsoft .NET 2.0 or later 

·  Outlook Web Access configured and running 

·  Member of the (Windows) Domain 

2.1.2 PSTWay Service for Outlook Server  

·  A separate server with Microsoft Outlook 2003 or 2007 installed 

·  Microsoft .NET Framework version 2.0 or later 

·  Outlook configuration  tested by connecting to Exchange server 

·  Member of the (Windows) Domain 

2.1.3 FileWay BackEnd and FileWay Manager Requireme nts 

·  FileWay BackEnd and FileWay Manager need to be installed on one server in the Domain.  
Commonly they are installed on one of the OWA servers but can be installed separately or on 
the PSTWay Service for Outlook Server. 

·  Microsoft WindowsTM 2003 or 2008 Server Standard, or Enterprise Edition, any service pack 

·  Internet Information Server (IIS)  

·  Microsoft .NET Framework version 2.0 or later 

·  Member of the (Windows) Domain 

2.2 Supported Browsers 

PSTWay supports Internet Explorer 6.0 and newer. 

2.3 Network Requirements 

The PSTWay and FileWay components must be installed in an environment where they are able to 
communicate with each other via TCP/IP and Windows File Sharing. All components will need to be running as 
members of a Microsoft Windows Domain. 
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3 Preparing for Installation 

The following steps should be followed before installing PSTWay: 

1. Select the servers on which you will install each component. 

2. Create a PSTWay domain user account to be used by PSTWay. 

3. Install Outlook 2003 or 2007 with any service packs on the PSTWay Service for Outlook Server. 

4. Install Microsoft .NET Framework version 2.0 or higher. 

5. Configure IIS as appropriate on OWA and FileWay BackEnd Server(s) 

Each step is explained below in further detail. 

3.1 Selecting Servers 

Before installing the software, you should select the server(s) on which you will install the various PSTWay 
components. In making your decision, there are various factors to consider such as the following: 

·  PSTWay Components for OWA should be installed on all of your MS Exchange 2007 Client 
Access servers that have OWA installed. 

·  You must install PSTWay for Outlook on a separate server that has Outlook (2003 or 2007) 
installed on it1. 

·  The PSTWay for Exchange 2007 Installer. exe will install a new FileWay BackEnd, FileWay 
Manager and even a Microsoft SQL Server 2005 Express Edition database instance for you.  
However you may wish to use an existing FileWay instance or an existing SQL Server instance. 

·  FileWay BackEnd (and FileWay Manager) only needs to be installed once on your domain. If 
there is an existing installation, you can point the PSTWay Components for OWA to that 
installation. If you decide to re-use the existing instance, the installer will upgrade FileWay 
BackEnd to the latest version.  If you decide to install a new instance of FileWay BackEnd, the 
installer will install it automatically. 

3.2 Creating PSTWay Admin Account 

PSTWay requires a domain account that has domain administration and user mailbox access rights.  Create a 
user account in Active Directory to fulfill this PSTWay Admin role. Then add this user to the Domain Admins 
Security Group.  

This account must have Full mailbox access for all users who need to use PSTWay. To give the PSTWay 
Admin user Full mailbox access to another user’s mailbox with Exchange 2007, proceed as follows: 

1. Access Microsoft Exchange Management Console. 

2. Expand Recipient Configuration in the Left-hand Pane and Select Mailbox . 

                                                 
1  Outlook is required because it provides the MAPI support required by PSTWay Service for Outlook.  
Since Microsoft does not support installing Outlook and Exchange Server on the same computer, Outlook must be 
installed on a separate server (or workstation) along with PSTWay Service for Outlook Server.  For details, refer to 
http://support.microsoft.com/kb/266418.  A server is preferred over a workstation because, among other reasons, 
servers are usually monitored and restarted in case of failure. 
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3. In the central pane (Mailbox Configuration Pane)  

a. Right-click each user that you wish to enable. 

b. Click Manage Full Access Permission. 

 

c. In the “Manage Full Access Permission” dialog, click the Add  button 
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d. Select the PSTWay Admin user and click OK  
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e. Click Manage.  The following dialog appears. 
 

 

f. Click Finish .  If you have successfully added PSTWay to the necessary accounts, please 
continue.  If you get any errors in the result dialog, resolve them before you continue on. 

 

4. Right-click  and repeat the procedure for all users who need access to PSTWay. If there are many users 
who need access to PSTWay, you can use a tool called ADModify to modify this attribute for multiple 
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users at the same time. Refer to Microsoft Product Support Services for more information about 
ADModify. 

3.3 Installing Outlook 2003 or 2007 on the PSTWay S ervice for Outlook Server 

Install Outlook 2003 or 2007 on the server you will be using as your  PSTWay Service for Outlook Server before 
installing PSTWay. This needs to be installed on a server that does NOT have Exchange installed on it. Only the 
minimal components are required. Refer to Microsoft Product Support Services for instructions explaining how 
install Outlook 2003 or 2007. 

3.4 Installing Microsoft .NET Framework 2.0   

Microsoft .NET Framework Version 2.0 must be installed on all servers hosting PSTWay software before you install 
PSTWay (.NET versions 3.0 and 3.5 include version 2.0 and should already be present on your  Exchange 2007  
OWA server(s).) Refer to Microsoft Product Support Services for instructions explaining how install .NET 2.0.  

3.5 Configuring IIS 

IIS needs additional configuration options for FileWay BackEnd and PSTWay for OWA servers. These differ 
between IIS 6 and IIS 7, refer to the appropriate instructions for your server(s). 

3.5.1 Configuring IIS 6 on Windows 2003 Servers 

Part of the Windows 2003 security options in Internet Information Services (IIS 6) is to allow the administrator to 
enable Active Server Pages (ASP) and Active Server Pages .NET (ASPX) or not. Since PSTWay is fully 
dependent on ASPs and ASPXs, those options have to be allowed on the IIS of Windows 2003 on any server 
that has PSTWay software installed (PSTWay includes PSTWay Components for OWA Servers, PSTWay 
Service for Outlook Server, and FileWay BackEnd with FileWay Manager). 

To allow ASPs and ASPXs on IIS 6, proceed as follows: 

1. Click Add Remove Programs > Add Remove Windows Components . 

2. Click Application Server  then click the Details  button. 

3. Select ASP.Net  (if not selected) then click OK followed by Next  and complete the installation process. 

Note: If ASP.Net is already selected, you can exit the setup without having to complete. 

4. Click Start > Administration Tools ->Internet Information  Services (IIS) Manager . 

5. Click the Web Service Extensions  in the tree. 

6. On the right-hand side, there appear three columns containing web service Extension  and Status . 

7. Read the status of the Active Server Pages  web service extension. 

If it is Prohibited , allow it (the allow button is to the left of the 3 columns) 

8. Read the status of the following web service extensions 

ASP .NET v1.1.xxx 
ASP .NET v2.xxxxx 
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9. If they are prohibited, allow them too. 

3.5.2 Configuring IIS 7 on Windows 2008 Servers 

All Windows 2008 servers running PSTWay For OWA components (MS Exchange OWA servers) or FileWay 
BackEnd (if installed on a separate server) need to have specific IIS settings to enable FileWay and/or PSTWay 
to function properly.  Note that for Exchange 2007 OWA servers most of this configuration will already be set.  

To begin, the IIS Server Role must be installed and the following "role services" should be selected for any 
server serving FileWay or PSTWay for OWA:  

·  Default Document 

·  Static Content 

·  HTTP Errors 

·  HTTP Redirection 

·  ASP.NET 

·  .NET Extensibility 

·  ASP 

·  ISAPI Extensions 

·  ISAPI Filters 

·  ALL the security roles (Basic, Windows, Digest, etc) 

·  IIS Management Console 

·  IIS 6 Metabase Compatibility 

·  IIS 6 WMI Compatibility 

In addition, the server which has FileWay BackEnd needs to allow certain privileges for the account (known as 
the FileWay Worker account) running the FileWay Upgrade scheduled task, especially if UAC (User Account 
Control)  is activated. There are 2 ways to allow this task to run properly: 

1. Disable UAC:  

a. Go to Control Panel | User Accounts | Turn User Account Control on or off. 

b. Clear Use User Account Control (UAC) to help protect your computer box. 

c. Click OK.  You will have to restart the server. 

 
OR  
 

2. Give the FileWay Worker account local administrative privileges on the BackEnd Server and then 
modify the scheduled task to run with the highest privileges: 
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a. Go to Administrative Tools | Task Scheduler | Task Scheduler Library. 

b. Select the task named FileWayUpdate. 

c. Select the task's properties and on the General Tab and ensure that the task is set to Run 
whether the user is logged on or not and that Run with highest privileges is selected.  

d. Click OK. 

4 Installing PSTWay 

Step 1: Install the PSTWay Service for Outlook on the PSTWay Outlook Server or workstation you selected. 
Refer to section 4.1. 

Step 2: Install (or upgrade) the FileWay BackEnd Components that are included in the PSTWay Components 
for OWA 2007 Servers installer. There are two slightly different configurations for this: 

·  You are installing (or upgrading) FileWay BackEnd on an Exchange 2007 OWA server on which 
you are also installing PSTWay for OWA. This is known as a “single host” installation.  This 
should be your only OWA server or the first OWA server you are installing on. 

·  You are installing (or upgrading) FileWay BackEnd on a completely separate server.  This may 
be an existing FileWay installation. In this case you still install FileWay BackEnd first using the 
PSTWay OWA installer but will only have the option to install or upgrade FileWay.  

In either of these cases you may choose to install new instances of FileWay BackEnd and the 
FileWay database, or upgrade existing instances. 

Step 3: Install the actual PSTWay Components for OWA 2007 Servers on all OWA servers.  If you are 
performing a “single host” installation as per Step 2 above, the installer will automatically continue to this 
step.  For all other OWA servers or for a separate installation you will have to run the installer again on 
each server. 

The Outlook Server installation is located in the “PSTWay Service for Outlook Server” folder in the “PSTWay 
v2.0 For Exchange 2007 Setup” package and the PSTWay Components for OWA servers are located in the 
“PSTWay Components for OWA 2007 Servers” folder as illustrated below: 
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4.1 First Step: Installing PSTWay Service for Outlo ok Server 

The PSTWay Service for Outlook Server component must be installed first. Proceed as follows:  

1. Run PSTWayOutlookServerSetup.msi  found in the folder named PSTWay Service for Outlook 
Server . The following dialog appears. 

 

2. Click Next . The following dialog appears. 

 

3. Click Next to use the default location or click Browse to select a different location in which to install 
PSTWay Service for Outlook Server . The following dialog appears. 
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4. Click Next . The following dialog appears. 

 

5. When step 4 is complete, click Next . The following dialog appears. 
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6. Enter the user name and password you created in section 3.2, then click OK. The following dialog 
appears.  

 

7. Enter the name(s) or IP address(es) of your Exchange mailbox server(s). For Windows 2008 domains 
we recommend that you use IP v4 addresses instead of names for your mailbox server(s).  

8. Click OK.  The following dialog appears. 

 

9. Click Close . 

4.2 Second Step: Installing FileWay BackEnd using P STWay OWA Server 
Components Installer 

1. To install or upgrade FileWay BackEnd for PSTWay, run PSTWay for Exchange 2007 Installer.exe 
found in the folder named PSTWay Components for OWA 2007 Servers in the install package.  The 
following dialog appears. 
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Note 1:  If you are installing FileWay BackEnd on a separate server (without OWA installed) the 
following dialog appears.  You may continue the installation by clicking OK. 

 

Note 2:  If you are upgrading an existing FileWay BackEnd server the installer will automatically 
detect this and begin to upgrade your installation if necessary. If this happens, skip ahead to step 24 
on page 29. 

2. On the welcome dialog, click Install PSTWay 2 to begin the installation. The following dialog appears 
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1. Click I accept the terms of the license agreement and then click Next .  

3. If you are installing on an OWA server in a Single Host  solution or as the first server among many, the 
following dialog appears. 

 

4. Select Single-Host: FileWay BackEnd, PSTWay Component  to install all PSTWay Components for 
OWA this server. Then click Next and skip to step 5. 

If you are installing FileWay BackEnd on a separate stand alone server the following dialog appears.  
Then click Next and skip to step 5. 
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In either case, the following dialog appears. 

 

5. Enter the user name and password you created in section 3.2. Enter the name or IP address of the 
designated Outlook Server on which you installed the PSTWay Service for Outlook Server component. 
Use the default Remoting Port, port 9000,  unless it is being used by another application. 

6. Click Next . One of the following dialogs appear. 
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Installing on OWA Server  

 

Installing on Separate Server  

 

In both cases, click Go. The following dialog appears. 
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7. FileWay Manager uses a Microsoft SQL Server database instance to store information in a database 
named “FileWay”. The installer allows you to create a FileWay database on an existing SQL Server 
instance on your network or create a new Microsoft SQL Server Express Edition instance and install 
the database on it. Start at a below to create a new instance or skip to d below to use an existing 
server. 

a. To create a new Microsoft SQL Server 2005 Express Edition instance on the server you are 
installing in, simply type in the name of the server into the SQL Servers  text box, provide a 
LoginID  and a Password  and click Connect : If there is no database server instance installed on 
the server, you will be prompted to install a new instance and a new database on this server, 
continue with section b.  If there is a database server instance installed on the server, skip to d 
below.  

b. If you there are no SQL Server Instances on your network, or you are creating a new instance, 
you will see the dialog below. Click Yes and continue to c below. 
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c. When installing a new SQL Server Express Edition Instance you will see this dialog: 
 

 
 
Enter a password of your choosing in the Password  textbox and click Install .  You will then see a 
command window and then the SQL Server Express Edition Installer: 
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When this completes you will see the Database Setup Complete Dialog: 
 

 
 
Click Next  and continue with step 11 below. 
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d. If you want to use an existing database server instance, you can search for it by clicking Get List . 
in the Database Setup Dialog. Setup will display a list of available databases in the SQL Servers 
field.  If there are more than one database available, you can view them using the pull-down menu. 
Select a database and enter a valid SQL Server LoginID  and Password  for that database 
server and click Connect  to continue to the next step. Note that you may only use SQL Server 
instances that are configured to allow remote connections and use SQL Server Authentication 
(a.k.a. Mixed Mode Authentication.) 

8. From the SQL Servers  field, select the database that you want to use with FileWay then enter the 
Login ID  and the Password  for the database server that has permissions to create a database. 

 

9. Click Connect . PSTWay Setup will then create the FileWay database. When this is complete you will 
see the following dialog: 
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10. Click Next . The following dialog appears. 

 

After a short while, the following dialog appears. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

22 

 

11. Click Next . The following dialog appears. 

 

12. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 
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13. Enter the reference name that you obtained from Everywhere Networks in the Reference Name field. 

14. Enter your registration key in the Registration Key field. 

If you do not have a registration key and would like to evaluate FileWay, you can obtain a trial license 
by clicking Get Code . When you upgrade your trial license to a full license, you will not need to 
reinstall the software. There is a way to register the new key. 

15. Once you entered your registration key, click Next . The following dialog appears. 

 

16. Click Next to use the default location or click Browse to select a different location in which to install 
FileWay. 

The following dialog appears ONLY if you have more than one web site; if it does not appear, 
PSTWay Setup will automatically be installed on the Default Web Site . 
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17. Select the web site on which you want to install FileWay BackEnd services then click Next . The 
following progress dialog appears. 

 

After a moment, the following dialog appears. 
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At this point, FileWay BackEnd is installed and the installation of FileWay Manager is about to 
begin.  

18. Click Finish . The following dialog appears. 

 

After a few moments, the following dialog appears. 
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19. Click Next . The following dialog appears. 

 

20. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 
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21. Enter your name and the name of your company and click Next . The following dialog appears. 

 

22. Click Next to install in the default location or click Change to select a different location in which to 
install FileWay Manager . The following dialog appears. 
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23. Click Install . The following dialog appears. 

 

After a moment, the following dialog appears. 
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You have now successfully installed FileWay BackEnd for PSTWay. If you are installing PSTWay 
Components for OWA Server on an OWA server, the installation will automatically continue as per 
section 4.3 below. 

24. If you are upgrading a FileWay BackEnd for PSTWay installation you should begin here. If the installer 
detects that an older version of FileWay BackEnd is installed on the current server, a dialog appears 
asking if you would like to upgrade.. If you are not prompted to upgrade, it means that the current 
server does not have FileWay BackEnd installed or you do not need to upgrade. 

 

25. Click Yes. After a few moments, the following dialog appears. 
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26. Click Next . The following dialog appears. 

  

27. Click Finish . 
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If the installer detects that an older version of FileWay Manager is installed on the current server, a 
dialog appears prompting you to upgrade FileWay Manager to the latest version. If you are not 
prompted to upgrade, it means that the current server does not have FileWay Manager installed or 
you do not need to upgrade. 

 

28. Click Yes. After a few moments, the following dialog appears. 

 

29. Click Next . The following dialog appears. 
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30. Click Finish . 

You have now successfully upgraded FileWay BackEnd for PSTWay.  

4.3 Third Step: Installing PSTWay Components for OW A 2007 Servers 

PSTWay Components for OWA 2007 Servers should be installed on all OWA servers in the domain.  If you 
installed FileWay BackEnd on an OWA server as per step 23 in section 4.2, Setup will automatically continue 
the installation at step 12 below on page 377 (OWAJScript Modifier Installation ). 

1. If you are installing PSTWay Components for OWA on a separate OWA sever, copy the PSTWay 
Components for OWA 2007 Servers folder from the install package to your OWA server and run the 
file PSTWay for Exchange 2007 Installer.exe . The following dialog should open: 
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2. Click Install PSTWay 2  and accept the License agreement in the following screen: 

 

3. Click Next  and choose PSTWay Component for OWA Servers  in the dialog below: 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

34 

 

4. Click Next . The following dialog appears. 

 

5. Enter the user name and password you created in section 3.2. Enter the name or IP address of the 
designated Outlook Server on which you installed the PSTWay Service for Outlook Server component. 
Use the default Remoting Port, port 9000, unless it is being used by another application. 

6. Click Next .  The following dialog appears. 
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7. Click Use an existing FileWay BackEnd  and then click Next .  The following dialog appears. 

 

8. Enter a user name that is configured in FileWay Manager as well as the IP Address or Name of the 
FileWay BackEnd Connection. 

9. Click Connect .  Resolve any connection errors that appear.  If the BackEnd Connection is successful, 
the following dialog appears. 
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.  

10. Click Next .  The following dialog appears.  
 

 

11. Click Go to begin installation of the Exchange Script Modification engine.  The following dialog 
appears. 
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For information about the script modifier, refer to section 12 on page 37. 
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If you are continuing an installation from step 23 on page 29 continue at the next step. 

12. Click Next . The following dialog appears. 

 

13. Select the Everyone button if you want any user to be able to run the Script Modifier executable. 

Select Just Me if you only want the user who is currently logged on to the server to be able to run the 
Script Modifier executable. 
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14. Click Next to use the default location or click Browse to select a different location in which to install. 
The following dialog appears. 

 

15. Click Next . The following dialog appears.  

 

After a few moments, the following dialog appears. 
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16. Click Close and continue with the next section. 
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The following dialog appears. 

 

17. Click Go and the final installation will begin with the following dialog. 
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18. Click Next . The following dialog appears. 

  

19. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 
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20. Click Next to use the default location or click Browse to select a different location in which to install. 
After a moment, the following dialog appears. 

After a moment, the following dialog appears. Press any key to continue. 

 

After a moment, the following dialog appears. 
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21. Click Finish . The following dialog appears. 

  

22. Click Next . The following dialog appears. 
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23. Click Next  to continue. Then Click Finish .  

At this point, all PSTWay for Exchange 2007 components are installed. Skip to section 5. 

5 Post-Installation Configuration Steps 

5.1 Adding the PSTWay ISAPI filter to the Website i n IIS 

This configuration step is required to implement “single sign on” so that once users have logged on to OWA, there 
is no need to re-authenticate when they use PSTWay. Installing an ISAPI varies between IIS 6 and IIS 7. 

5.1.1 PSTWay ISAPI filter in IIS 7 

1. Open IIS Manager and navigate to the Sites  Folder in the Navigation Pane (left hand pane). 

2. Select the website under which Exchange is installed (which is usually the Default Web Site). 

3. In the central pane, select Features View    

4. Locate the ISAPI Filters  Feature and double-click  it 

5. In the action pane select Add…  (or right click in the Central Pane and select Add… ) 

6. Enter a name for this ISAPI Filter, for example, PSTWay Filter. 

7. Click the browse  button (indicated by an ellipsis) for the Executable:  text box and navigate to the 
following folder: \Program Files\ENC\PSTWay\PSTWayISAPI and select the following file: 
PSTWayISAPI64bit.dll. 

8. Click OK to save the filter. 
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5.1.2 PSTWay ISAPI filter in IIS 6 

1. Open IIS Manager and expand Websites . 

2. Right-click the website under which Exchange is installed (which is usually the Default Website). 

3. Select Properties. 

4. Click the ISAPI Filters tab. 

5. Click the Add button. 

6. Enter a name for this ISAPI Filter, for example, PSTWay Filter. 

7. Click Browse and navigate to the following folder: \Program Files\ENC\PSTWay\PSTWayISAPI and 
select the following file: PSTWayISAPI64bit.dll. 

8. Click OK twice to exit the Website properties. 

 

6 FileWay Concepts 

As an Administrator, you can specify access rules on an individual user basis. However, this approach can 
become unmanageable in an organization with more that 25 users. 

A more efficient approach is to specify access rules for many users at a time based on a variety of criteria. 

Both approaches are described below. 

6.1 Rule Sets 

Rule sets comprise the following elements: 

·  Members 

·  Resources 

Rule sets combine members (i.e. users) and resources to create access rules in a way that is logical for a given 
rule set. For example, a rule set called Sales could contain all employees working in the Sales department and 
would provide those employees with access to the resources that they need. 

6.1.1 Rule Set Resources 

Resources contain multiple references to folders and shares from different computers and servers. Resources 
can also contain multiple references to computers. Refer to the two following figures. 
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6.1.2 Rule Set Members 

Members can contain references to individual users and groups in your Active Directory. Rule sets can also 
contain other rule sets. A user can be a member of multiple rule sets. Refer to the two following figures. 
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6.2 Individual Users 

Some users will require resources that are unique to them. In such cases, a rule set would only have one 
member; therefore, it is more practical to assign resources to those individual users. This is achieved using 
virtual machines. 

To assign resources to an individual user, you must create a virtual machine for that user. The user must 
already exist in Active Directory. Then you add resources to the virtual machine. Refer to the figure below to 
see virtual machines assigned to a user. In this example, user John Smith has a virtual machine called Special 
that contains the Specialized Equipment resource. Therefore, John would have access to that resource. 

A user may have more than one virtual machine. One reason to use multiple virtual machines is to organize 
resources in a particular way for a given user. 

Note that adding a virtual machine with resources to individual users does not preclude those users from being 
members of one or more rule sets. 

 

7 Planning Access Rules for Multiple Users 

As described in the concepts section above, you have several components to work with: individual users and 
groups in your Active Directory, rule sets, folders, shares and computers. You should plan how to group these 
components. 

Begin with rule sets. Rule sets can be named according to functional groups within your organization, for 
example, Sales, Marketing , Engineering and Research could be four rule sets. The name of the rule set 
will appear to end-users as a virtual machine when they login to FileWay. Rule sets can have imbedded 
rule sets; for example, if you needed a rule set called Sales & Marketing , you could add the existing Sales rule 
set and the Marketing rule set. 

Next, decide which members should be part of a given rule set (i.e. users, groups and imbedded rule sets). 
These users and groups come from your organization’s Active Directory. For example, a rule set called Sales 
would likely contain one or more existing groups and maybe individual users or imbedded rule sets as required. 

Next, decide which resources must be added the Sales rule set. Resources are a collection of references to 
folders, shares and computers. 

Once you have planned your rule sets, members, resources and attributes, start using FileWay Manager. 

8 Making Users' PST Files Accessible in OWA 

There are a few ways to make users' PST files available to them in OWA. 
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If your organization specifies users' home directories in Active Directory, instruct users to store their PST files in 
any folder within their home directory. Then, create a rule set that allows users to access their PST files and 
ensure that you select the Include Home Directories Folders check box. Refer to Creating a Rule Set  on page 
48 for the procedure for creating a rule set. This approach applies regardless of whether users' home directories 
are on their local computer or on a network server. 

If your organization does not specify users' home directories, then you have the following options: 

·  Use Active Directory to specify each user’s home directory and point the home directory to the 
location where the users store their PST files. Then, create a rule set that allows users to 
access their PST files and ensure that you select the Include Home Directories Folders  check 
box. Refer to Creating a Rule Set  on page 48 for the procedure for creating a rule set. This 
approach applies regardless of whether users' home directories are on their local computer or 
on a network server. 

·  When there is a mix of PST files stored on users’ computers and on the network, you can use a 
rule set with assignable fields to make users' PST files accessible remotely via OWA. Refer to 
the notes below for more details about using assignable fields with rule sets. This approach is 
most effective for organizations that use consistent computer naming conventions. 

·  For users who store their PSTs on the network, you can use virtual machines to allow users to 
access their PSTs remotely via OWA. Refer to Creating Access Rules for Individual Users 
on page 61 for a description of the steps to be followed. 

A few notes about using assignable fields: FileWay Manager provides assignable fields that you can use 
when assigning resources to a rule set. The fields are: %groupname% and %username% . The following are 
examples of how you could use assignable fields when assigning resources to a rule set. 

Example using the %username% assignable field 

Some users each have their own folder on the network and the name of each folder is the same as each user’s 
user name. 

These users store their PST files in their respective folders. 

When you assign resources to a rule set, specify the %username% assignable field in the path to the resource, 
for example, \\servername\User Folders\%username%. 

From OWA, the members of the rule set will have access to their respective PST files. 

Example using the %groupname% assignable field 

Some users who are members of a group that shares a folder on the network and the name of the folder is the 
same as the name of the group. 

These users store their PST files in the shared folder. 

When you assign resources to a rule set, specify the %groupname% assignable field in the path to the resource, 
for example, \\servername\User Folders\%groupname%. 

From OWA, the members of the rule set will have access to their respective PST files. Refer to Adding Custom 
Resources to Members of a Rule Set  on page 60. 
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9 Using FileWay Manager 

9.1 Starting FileWay Manager 

FileWay Manager should have been installed on the same server as the FileWay BackEnd Server. There 
should be a short cut on the desktop to start FileWay Manager. Double-click the short cut to start FileWay 
Manager. 

 

When you first run FileWay Manager, the FileWay Manager main window appears displaying the Individual 
Users and Rule Sets icons in the left pane of the main window. 

 

9.2 Stopping FileWay Manager 

To stop FileWay Manager, click File > Exit . 

You will be prompted to update the FileWay Database. If you update the FileWay Manager database, any 
changes you made since the last time the database was updated will take effect. This is important if you changed 
access privileges in some way, for example, deleting a rule set. 

If you do not update the FileWay Manager database, any changes you made since the last time the database 
was updated will only take effect the next time the FileWay Manager scheduled task is executed. 

9.3 Creating Access Rules for Multiple Users 

The general steps are as follows: 

1. Create the rule set. 

2. Add members to the rule set. 

3. Add resources to the rule set. 

Refer to the subsections below for details on each step. 

9.3.1 Creating a Rule Set 

To create a rule set, proceed as follows: 

1. Right-click the Rule Sets icon. 
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A pop-up menu appears. 

2. In the pop-up menu, click Create Rule Set . 

The Create Rule Set dialog appears. 

 

3. In the Virtual Machine Name field, enter a name for the rule set, for example, Sales. 

End-users will select this virtual machine to access the resources of the rule set. 

4. Click the Include Home Directories Folders check box if you want users to be able to access their 
home directory (as specified in Active Directory). 

5. Click Create Rule Set. 

The main FileWay Manager window re-appears displaying the new rule set in the right pane. 

6. Double-click the new rule set to expand it. 

The two elements of the new rule set appear: Members and Resources . Refer to the figure below. 

 

9.3.2 Adding Members to a Rule Set 

Members can be groups, users and other rule sets. 

Note: The next three procedures assume that the Members and Resources icons appear in the left and right 
panes for the selected rule set as shown in the previous figure. If necessary, expand the Rule Sets icon and/or 
the rule set you want to modify. 

9.3.2.1 Adding Groups to a Rule Set 

1. Right-click Members . 

A pop-up menu appears. 
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2. From the pop-up menu, click Edit Group List . 

The Edit Group List dialog appears. Use this dialog to search for the group(s) you need, for 
example, Sales. 

 

3. Select the Domain from which you want to add a group. 

Note: Before you can select trusted domains, you must first add the trusted domains to the FileWay 
domain list. Refer to Adding Trusted Domains  on page 64. 

4. In the Starts With field of the Edit Group List dialog, enter the name of the group you want and click 
Search to find the group in Active Directory. 

If you prefer to browse for the group name, enter nothing in the Starts With field and click Search . 
The result of the search appears below the Search Results list. 

5. Select one or more groups you want, and click Add Groups . You can also double-click a group to 
select it. 
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The selected groups appear in the Members list. 

6. Click OK when you have selected all the groups you need. 

The main FileWay Manager window reappears displaying the group(s) you just added. The domain to 
which the group belongs also appears. 

 

9.3.2.2 Adding Users to a Rule Set 

The process for adding users is almost identical to adding groups. From the Members pop-up menu, select 
Edit User List and the Edit User List dialog appears. From that point, the process is the same as adding 
groups. 

9.3.2.3 Adding Other Rule Sets to a Rule Set 

The process for adding rule sets to another rule set is almost identical to adding groups. From the Members 
pop-up menu, select Edit Rule Set List and the Edit Rule Set List dialog appears. From that point, the 
process is the same as adding groups. 

In the figure below, you can see that the Students rule set is imbedded into the Test rule set. This means that 
users who are members of the Students rule set can also access the resources specified in the Test rule set. 
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9.3.3 Adding Resources to a Rule Set 

There are two approaches to specifying resources within a rule set: 

·  You may specify a computer, share or a folder within a share to be accessible by all members 
of the ruleset. 

·  You may specify a custom resource with fields that are replaced when the resource is written to 
the FileWay database. 

9.3.3.1 Assigning Resources to Members of a Rule Se t 

Proceed as follows to add resources to your rule set: 

Note: This procedure assumes that the Members and Resources icons appear in the right and left panes for the 
selected rule set as shown below. If necessary, expand the Rule Sets icon and/or the rule set you want to 
modify. 

 

1. Right-click Resources and select Add Resources from the pop-menu. 

The Add Resources dialog appears. 
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2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to your rule set. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

 

Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
members of the rule set. In addition, the computer will appear to users as a network drive icon instead of a 
computer icon. 

At this point, you have created a rule set containing users and resources. Repeat the process to create more 
rule sets. 

9.3.3.2 Assigning Custom Resources to Members of a Rule Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group. 
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For examples of how you may use assignable fields, refer to Making Users' PST Files Accessible in OWA  on 
page 46. 

Proceed as follows to add custom resources to your rule set: 

Note: This procedure assumes that the Members and Resources icons appear in the right and left panes for the 
selected rule set as shown below. If necessary, expand the Rule Sets icon and/or the rule set you want to 
modify. 

 

1. Right-click Resources and select Add Custom Resource from the pop-menu. 

The Add Custom Resource dialog appears. 

 

2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource dialog, 
type a backslash at the end of the path. 

4. Click %username% to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname% to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

55 

9.4 Viewing Members of a Rule Set 

Within of a rule set, you can view the members of groups and the members of imbedded rule sets. In the figure 
below, you can see that the Engineering rule set is imbedded into the Sales rule set. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set for which you want to view the members. 

 

9.4.1 Viewing Members of Group within a Rule Set 

To view the members of a group within a rule set, proceed as follows: 

1. Double-click the group for which you want to see the members. 

2. A dialog appears showing the users who are members of the selected group. 

3. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

9.4.2 Viewing Members of a Rule Set within a Rule S et 

To view the members of an imbedded rule set, proceed as follows: 

1. Double-click the imbedded rule set for which you want to see the members. 

2. A window appears showing the users that are members of the selected imbedded rule set. 

3. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

9.5 Modifying Rule Sets 

You can make the following changes to a rule set: 

·  Change characteristics of the rule set itself 

·  Change its Members 

·  Change its Resources 
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Note 1: When you make any changes in FileWay Manager, and you want the changes to take effect 
immediately, update the FileWay database by selecting the following command from the Tools menu: Write 
Configuration to FileWay Database . 

Note 2: The following procedures assume that the rule sets appear in the left pane as shown in the following 
figure. If necessary, expand the Rule Sets icon. 

 

9.5.1 Changing Characteristics of Rule Sets 

You can make the following changes to a rule set: 

·  Rename 

·  Delete 

·  Change properties 

9.5.1.1 Renaming a Rule Set 

To rename a rule set, proceed as follows: 

1. Right-click the rule set you want to rename. 

A pop-up menu appears. 

 

2. From the pop-up menu, click Rename Rule Set . 

The name of the rule set is highlighted. 
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3. Type the new name for the rule set and press Enter. 

9.5.1.2 Deleting a Rule Set 

To delete a rule set, proceed as follows: 

1. Right-click the rule set you want to delete. 

A pop-up menu appears.  

2. From the pop-up menu, click Delete Rule Set . 

A verification dialog appears asking you to confirm the deletion.  

3. Click Yes. 

The rule set is removed from the list of rules sets. 

9.5.1.3 Changing Rule Set Properties 

To rule set properties, proceed as follows: 

1. Right-click the rule set whose properties you want to change. 

A pop-up menu appears. 

2. From the pop-up menu, click Properties . 

The Rule Set Properties dialog appears.  

3. Select or deselect the Include Home Directories check box if you want users to be able to access 
their home directory (as specified in Active Directory). 

4. Click OK. 

The main FileWay Manager window re-appears. 

9.5.2 Changing Members of a Rule Set 

Members can be groups, users and other rule sets. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set you want to modify. 
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9.5.2.1 Deleting a Single User from a Rule Set 

To delete a user from a rule set, proceed as follows: 

1. Right-click the user that you want to delete and select Delete Members . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 

9.5.2.2 Adding or Deleting Multiple Users to or fro m a Rule Set 

To add and/or delete multiple users from a rule set, proceed as follows: 

1. Right-click Members  in the left pane. 

A pop-up menu appears.  

2. From the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying users that are already members of the rule set.  
 
Use this dialog to search for the user(s) you need.  

3. In the Starts With field of the Edit User List dialog, enter the name of the user that you want to add. 

If you prefer to browse for the group name, enter nothing in the Starts With field and click Search .  
 
The result of the search appears below the Search Results list.  

4. Select one or more users that you want, and click Add Users . You can also double-click a user to 
select it. 

The selected users appear in the Members list.  

5. You can delete multiple users from the rule set by selecting them in the Members list and clicking 
Remove . A verification dialog will appear asking you to confirm the deletion. 

6. Click OK in the Edit User List dialog when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the users(s) you added. 

9.5.2.3 Deleting a Single Group from a Rule Set 

To delete a group, proceed as follows: 

1. Right-click the group that you want to delete and select Delete Group . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 
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9.5.2.4 Adding or Deleting Multiple Groups to or fr om a Rule Set 

The process for adding and/or deleting multiple groups is almost identical to adding and/or deleting multiple 
users. From the Members pop-up menu, select Edit Group List and the Edit Group List dialog appears. 
From that point, the process is the same as adding and/or deleting multiple users. 

9.5.2.5 Deleting a Single Rule Set from a Rule Set 

To delete a rule set within a rule set, proceed as follows: 

1. Right-click the rule set that you want to delete and select Delete Rule Set . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members. 

9.5.2.6 Adding or Deleting Multiple Imbedded Rule S ets to or from a Rule Set 

The process for adding and/or deleting multiple rule sets within one rule set is almost identical to adding and/or 
deleting multiple users. From the Members pop-up menu, select Edit Rule Set List and the Edit Rule Set List 
dialog appears. From that point, the process is the same as adding and/or deleting multiple users. 

9.5.3 Changing Resources of a Rule Set 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set you want to modify. 

 

9.5.3.1 Deleting a Single Resource from a Rule Set 

To delete a resource, proceed as follows: 

1. Right-click the resource that you want to delete and select Delete Resources . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining resources. 

9.5.3.2 Adding Resources to a Rule Set 

To add a resource to a rule set, proceed as follows: 
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1. Within the relevant rule set, right-click Resources and select Add Resources from the pop-menu. 

The Add Resources dialog appears.  

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to your rule set. These would be resources that only members of the rule set may access. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 

The main FileWay Manager window re-appears displaying the resource you added.  

 

4. Repeat until you have selected all the resources you need. 

Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
members of the rule set, more specifically, the FileWay end-users. In addition, the computer will appear to end-
users as a network drive icon instead of a computer icon. 

9.5.3.3 Adding Custom Resources to Members of a Rul e Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group. 

For examples of how you may use assignable fields, refer to Making Users' PST Files Accessible in OWA  on 
page 46. 

Proceed as follows to add custom resources to your rule set: 

1. Right-click Resources and select Add Custom Resource from the pop-menu. 

The Add Custom Resource  dialog appears.  

2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource dialog, 
type a backslash at the end of the path. 

4. Click %username% to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname% to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane.  
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5. Repeat until you have added all the custom resources you need. 

9.6 Creating Access Rules for Individual Users 

Sometimes, rule sets may not the best approach for assigning resources to a user. In this case, you can assign 
resources to individual users. 

To assign resources to individual users, you must create one or more virtual machines for each individual user. 
The user must already exist in Active Directory. Then you add resources to the appropriate virtual machine. 
One reason to use multiple virtual machines per user is to group the resources in a particular way. Refer to the 
figure below to see virtual machines assigned to individual users. 

 

When users attach a PST file in OWA, they will need to search for it. When they do, they will need to locate the 
virtual machine you created using FileWay Manager. The Virtual Machine will appear as shown in the figure 
below. 

 

The general steps for creating access rules for individual users are as follows: 

1. Add the user in FileWay. 

2. Add a virtual machine to the user. 

3. Add resources to the virtual machine. 

Refer to the subsections below for details on each step. 
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9.6.1 Adding a User 

To add an individual user, proceed as follows: 

4. Right-click the Individual Users icon. 

A pop-up menu appears.  

5. In the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying a list of users who already have had resources 
assigned directly to them.  
 
Use this dialog to search for the user that you want to add. 

6. In the Starts With field of the Edit User List dialog, enter the name of the user you want and click 
Search to find the user in Active Directory. 
 
If you prefer to browse for the user name, enter nothing in the Starts With field and click Search . 
 
The result of the search appears in the Search Results list. 

7. Select one or more users you want, and click Add Users . You can also double-click a user to select it. 

The selected user(s) appear in the Members list.  

8. Click OK when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the user(s) you just added. 

9.6.2 Adding a Virtual Machine to a User 

To add a virtual machine to a user, proceed as follows: 

1. Right-click the relevant user. 

A pop-up menu appears.  

2. From the pop-up menu, click Add Virtual Machines . 

The Add Virtual Machines  dialog appears.  

3. Click Create Virtual Machine . 

The Create Virtual Machine  dialog appears.  

4. Enter the name of the Virtual Machine . 

5. Click Create Virtual Machine . 

The name of virtual machine appears below the user.  

You may add as many virtual machines as required. 
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9.6.3 Adding Resources to a Virtual Machine 

To add a resource to an individual user’s virtual machine, proceed as follows: 

1. Right-click a virtual machine and select Add Resources from the pop-up menu. 

The Add Resources dialog appears.  

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to the user. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 

The main FileWay Manager window re-appears displaying the resource you added.  

4. Repeat until you have selected all the resources you need. 

Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
relevant FileWay end-user. In addition, the computer will appear to end-users as a network drive icon instead of 
a computer icon. 

9.6.4 Deleting a User 

To delete an individual user, proceed as follows: 

1. Right-click the user you want to delete. 

A pop-up menu appears.  

2. In the pop-up menu, click Delete User . 

A confirmation dialog appears.  

3. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining user(s). 

9.6.5 Renaming a User's Virtual Machine 

To rename a user’s virtual machine, proceed as follows: 

1. Right-click the virtual machine that you want to rename. 

A pop-up menu appears.  

2. From the pop-up menu, click Rename Virtual Machine . 

The name of the rule set is highlighted.  

3. Type the new name for the rule set over the old and press Enter. 

9.6.6 Deleting a User's Virtual Machine 

To delete an individual user’s virtual machine, proceed as follows: 
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1. Right-click the user you want to delete. 

A confirmation dialog appears.  

2. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining virtual machines. 

9.6.7 Deleting a Resource from a User's Virtual Mac hine 

To delete a resource, proceed as follows: 

1. Display the user’s resources in the right pane of FileWay Manager. You may need to expand the 
user’s name and possibly double-click the virtual machine name. 

2. Right-click the resource that you want to delete and select Delete Resources . 

A verification dialog appears asking you to confirm the deletion.  

3. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining resources. 

10 Managing the FileWay Database 

10.1 Adding Trusted Domains 

When creating rule sets, you can choose users, groups and resources from trusted domains within your 
organization; however, before you can access trusted domains from within FileWay, you must add the trusted 
domains to the list of domains that FileWay can use. 

Proceed as follows: 

1. Click Tools > Domain List . 

 

The following dialog appears listing all the trusted domains within your organization. The host domain 
is the one in which FileWay is installed.  



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

65 

 

2. Select the trusted domain you want and click Add Domains . 

3. Click OK to finish. 

10.2 Viewing the Current Contents of the Database 

Select Tools > Show FileWay Database to get a quick and complete view of all rule sets and their members 
and resources, as well as individual users and their virtual machines and resources. Refer to the figure below. 

Note that you should update the FileWay Manager database before viewing the contents of the database in this 
manner. Viewing the database in this way allows you to quickly check whether changes you made in FileWay 
Manager were written to the database. 

Viewing the database is useful for debugging purposes, for instance, to check if a certain user has access to a 
certain resource. 
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10.3 Scheduling Daily Updates for FileWay Manager D atabase 

You can configure FileWay Manager to automatically update the FileWay Manager database on a scheduled 
basis. Click Tools > Schedule FileWay Database Updates and the following dialog appears. 

 

Select the schedule that suits your requirements and click OK. 

Note if you choose to schedule updates to the database, keep in mind that if you make changes in FileWay 

Manager that must be applied immediately, use the procedure in the next section. 

10.4 Updating the Database with Latest Changes 

When you make any changes in FileWay Manager, and you want the changes to take effect immediately, update 
the FileWay database by selecting the following command from the Tools menu: Write Configuration to 
FileWay Database . 
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If changes are made to Active Directory that impact FileWay, for example, removal of users or groups, run Write 
Configuration to FileWay Database . If you find that the changes were not propagated to FileWay Manager, 
Active Directory will need to be closed and re-opened. 

11 PSTWay End-User Notes 

This section describes an OWA user’s view of PSTWay. 

11.1 Attaching PST file 

1. To attach a PST file to OWA, click the Options button in the left bottom pane of OWA. The following 
pane appears within OWA. If prompted, enter your domain username and password. 

 

2. Click the Browse button and find the PST file. 
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3. Once you have found the PST file, select the filename and click Add PST . The window is refreshed 
and the filename appears the PST UNC Path field. 

 

4. Alternatively, you can enter the UNC path to the PST file directly into the PST UNC Path field, for 
example, \\servername\sharename\filename.pst. 

5. If the PST file is password-protected, enter the password in the PST Password field. 

6. Click the Add button. The folder list on the left upper pane is refreshed automatically and the new PST 
file appears in the list below the PSTWay folder. 
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You may add more PSTs if necessary. 

Note : If you want remove a PST from the list of added PST files, do not delete it from the folder list; 
instead, refer to Removing a PST File  on page 70. If you delete the PST from the folder, you will be 
actually deleting the entire PST file. 
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11.2 Viewing PST File 

To view the contents of the PST file, expand the PSTWay folder on the left upper pane. All attached PST files 
should appear. Expand a PST filename to view its contents. If prompted, enter your domain username and 
password. 

 

11.3 Adding and/or Removing Contents in the PST Fil e 

Once you have attached a PST file, you can add items like email messages or contacts to it. You can do this by 
dragging an item from an OWA folder into the corresponding folder in the PST. 

You can delete items from an attached PST, which will permanently remove the item from the PST file. You can 
reply to and forward messages from the PST. Finally, you can edit contacts etc. and save the changes 

Note: If you want to remove a PST, do not delete it from the folder list; instead, refer to Removing a PST File  on 
page 70. If you delete the PST from the folder, you will be actually deleting the entire PST file. 

11.4 Removing a PST File 

When you no longer want a PST file to be attached in OWA, you can remove it as follows. 

1. Click the Options  button. If prompted, enter your domain username and password. 

2. Select the PST file in the listing of attached files. 
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3. Click the Remove button. The folder list is refreshed automatically after this change and you will see 
that the PST file is gone. 

Note: Removing a PST file does not delete the PST file from its saved location; removing a PST file simply 
makes the file inaccessible from OWA. 

12 Troubleshooting 

If, after installing a hot fix or service pack for Exchange Server 2007, you notice changes in how PSTWay 
functions, it is possible that some PSTWay scripts may have been overwritten during the upgrade. You may 
notice that you are missing some of the functionality of PSTWay in OWA. The figure below shows an example of 
the PSTWay functions on the Options page. If PSTWay scripts were overwritten by an Exchange update, this 
section may be missing. In this case, you will need to run the Script Modifier to repair the overwritten files. It is not 
necessary to run the Script Modifier after each Exchange Server upgrade; it only needs to be run if PSTWay 
loses functionality. 
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If you need to run the Script Modifier, execute the following: 

Program files\enc\encscriptmodifier\Pstwayinstall.b at 

A Command Prompt window will open showing the script being executed. 

When the script finishes, press any key the command window and the scripts will be updated. 

 

 


